Chapter 3 Getting Started

Overview
This chapter describes how to:

Start Backup Director

Perform an automatic backup job
Monitor a job in progress

View the results of the automatic job
Manage the job queue

View system messages

View tree structures and select items
Add users

Customize the user interface
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Introduction

If you've installed Backup Director correctly, you are ready to begin using this
comprehensive data protection tool!

To start Backup Director
1. Log in as the user you defined during installation.

2. From Windows Program Manager, click the Backup Director icon from the appropriate
group window. The Control Console window appears.



Control Console

The Control Console is the nerve center of your installation. From this manager, you can
understand basic information about your entire installation.

The tabs on the Control Console's Control Panel window provide brief descriptions of the
managers and menu options that you can choose from Control Console. The four tabs are:

Basics
Status
Reports
Managers

Basics Tab

When you select an icon representing a basic operation or feature, a Palindrome Cue Card
window briefly describes the various options and prompts you to access the appropriate
manager or window. Additional cue cards further describe the operation or feature. You can
choose Close to return to the Control Console.

Backup

The program describes different types of backup operations. At the cue card prompt,
indicate whether you want to proceed with an operation. The program takes you to the
appropriate manager and window. A cue card tells you how to complete the operation. For
more information about specific types of backup operations:

. To back up a resource, see chapter 5.
. To back up a directory or file, see chapter 5.
. To back up all protected resources using configured automatic

operations, see chapter 3. Also, Chapter 2, “Backup Concepts,” contains
background information about automatic operations.

Restore

The program describes different types of restore operations. At the cue card prompt,
indicate whether you want to proceed with an operation. The program takes you to the
appropriate manager and window. A cue card tells you how to complete the operation. For
more information about specific types of restore operations:

. To restore a file or directory, see chapter 6.
. To restore an entire resource, see chapter 6.

Media and Devices

The Palindrome Cue Card briefly describes the devices that can be added, supported
firmware, and AutoLoader Software. The cue card also describes the types of media it uses.
At the prompt, indicate whether you want to proceed with an operation.

A cue card tells you how to complete the operation. For more information about the media
and device operations:



. To format media, see Chapter 10, “Managing Media.”

. To add a device, see Chapter 11, “Managing Devices.”

. To change the configuration of a device or autoloader, see Chapter 11,
“Managing Devices.”.

Automatic Operation

The Palindrome Cue Card briefly describes the configurable parameters for automatic
operations. Indicate which feature you want to configure. A cue card tells you how to
configure the feature. For more information about the automatic operations parameters:

. To specify the servers and resources the program backs up, see
chapter 8.

. To specify at what time and how frequently the program performs the
automatic operations, see chapter 5.

. To specify which operations to perform, see chapter 4 for parameter

descriptions. See Chapter 2, “Backup Concepts” for background information
about automatic operations.

SmartAlerts

SmartAlerts are icons that represent types of problems that can occur at your installation. It
is important to understand what they mean so that you can respond to them appropriately.
Information about alerts also appears in Chapter 7, “Managing Jobs.”

Status Tab

Items on this tab display the changing status of your installation's jobs and media.
Reports Tab

Items on this tab display configuration and rotation information for your installation.

Managers Tab

Items on this tab access other Backup Director managers.

Performing Your First Backup

Backup Director comes with default parameters already set for the system, operations, and
the rotation schedule of managed media.

Automatic means that Backup Director automatically determines:

. Which operation to perform—Automatic jobs include database
maintenance and backup operations. Automatic jobs perform different
operations on rotation and non-rotation days.

. Which media to use

. When to perform the backup

. When to move media sets on-site and off-site



See chapter 4 for information about media scheduling (automatic job) parameters.
To submit an automatic job
1. Load media in the backup device.

2. From the Control Panel window, open the Operations menu and select the Automatic
option (this option is also in Resource Manager). A prompt asks if you want the
program to prompt you with questions. These questions are typically related to the
media or device. The Automatic option is also available on the Operations menu in
Resource Manager.

If you choose No, you are allowing the program to determine how to proceed with a
job if it encounters a problem. This is unattended mode.

If you choose Yes, the program may prompt you to respond to media or
hardware messages. This is attended mode. If no one is available to respond
to a prompt, the program will wait indefinitely for a response.

3. Regardless of the mode you select, an Establishing Communications window displays
the job ID assigned to the automatic job and its status in the job queue. The program
begins processing this job as soon as possible.

To change the schedule of the automatic job

> From the Status tab select the Job Queue icon. If the “Default
Automatic” job is in the “ready” state, highlight it and select the View button.
By default, automatic jobs are scheduled to begin processing at 6 p.m.
Monday through Sunday. If you would like to change this schedule, see
chapter 5 for information about editing the schedule parameters.

Monitoring Jobs

You can monitor jobs from any manager at the time you submitted the job or, at any time,
from the Control Console. Once the program begins processing a job, you can view its
progress.

The Backup Job Status window, displays general information about the resources selected for
the current job and which resources the program has completed processing so far. The
Backup Operation Status displays additional detail. Your first few automatic jobs will take a
relatively long time to complete.

To view a backup job in progress

> From the Job Queue window, highlight a backup job that the program is
currently servicing and choose the View button. The Backup Job Status
window appears.

—To view details of the current backup job, choose the
View button. The Backup Operation Status window appears.
This window displays information about the operation(s), the
device being used, the activity the device is performing, etc.

—To view details of all processes the program is running
concurrently, choose the View All button.



TIP: While you can continue monitoring job until it completes, you will
improve performance by closing its job status or operation window when you
are satisfied that the job is running smoothly. If you want to monitor the job
later, you can view the job only through Control Console's Job Queue window.

Alert Button

The program does not force you to address an alert; you can continue doing other work. The
button appears on a job status or operation status window only when an alert condition
exists. This job cannot proceed until you correct a problem. When you are ready to address
the alert, choose the Alert button to display the system message again. See chapter 7 for
more information about alerts.

Abort Button

The Abort button on the job status windows can be used to stop the processing of a job.

To abort a job

1. From the job status windows, choose Abort. A prompt appears.
2. Confirm that you want to abort the job. Close the job status window.
After the Job Completes

There are several ways that you can confirm the results of an automatic job:

o Last Automatic window-Displays the status of the operation for
each resource and automatically filters system messages for that specific
automatic job.

o System Messages window-Displays all of the messages available
for completed jobs.
o Alerts palette—Indicates whether a condition exists that requires

corrective action.
[ ]

File Manager—The File History window indicates the latest version recorded
by the database.

Media Manager—The session information includes the time the session was
written and the label of the media it is located on.

Last Automatic Window

To view system messages for a recent automatic job

1. From the Status tab, choose the Last Automatic icon. The Last Automatic window
appears. This window displays the results of the most recent automatic job.

2. From the Last Automatic window, choose the Messages button. The System
Messages window automatically filters system messages based on the job ID of the
most recent automatic job.



System Messages

Backup Director records messages generated by jobs directly in the System Messages
window.

The default view of the System Messages window displays all of the system messages,
including linked messages, for the most recent jobs. The most recent system messages
appear at the top of the list. Linked messages provide detailed information and appear
indented below the primary message.

To view a system message

1. Highlight a system message in the System Messages window. The full description of
the system message and any recommended action appear below the system
messages.

2. Use the thumb button or arrow key to view additional available messages in the
window

> If the More button is active, you can view more messages. Choose this

button and continue to scroll through the list of available messages. Continue
this method of browsing the database until you have found the items you are
looking for or the More button is no longer active.

To view details about the message
1. Highlight the system message.

2. Choose the Details button. The System Message window appears. Use the Next
button to view any linked messages.

Alerts Palette

The icons in the alerts palette represent types of problems that need corrective action. The
alerts identify general problems relating to jobs, the job server, media, and devices. If an
alert is active (appears in color), warning or error messages exist. Click the active alert to
view details about the problem. Tool Tips describe the meaning of each alert.

See chapter 7 for more information about alerts.
File Manager

The File History Database automatically records files that have been backed up during
automatic operations. To view the media locations of file versions, you can view the
Extended History window in File Manager. This window displays the label of the media that
the file version was written to and the time and date the operation occurred.

Media Manager

You can view the latest session written to a media by viewing your installation's media tree.
Session information includes the time and date of the most recently written session. If Media
Manager was open when you submitted the job, you must select Refresh Media Tree to
display the latest backup job.



Custom Jobs

By using managers, you can select specific items for backup or restore operations. Jobs
defined in this way are called custom jobs. Custom jobs provide greater flexibility than
automatic jobs. They allow you to:

Use managed or non-managed media.

Include the entire Protected Resource List or specific resources or files.
Perform any single operation (backup, restore, or utility operation).
Perform the operation once, periodically, or following another
scheduled job.

Selecting Items

Custom jobs require the user to select the items for an operation. The Resource, File, Media,
and Device managers present items in a tree structure to illustrate a hierarchy of items.

To select a manager

> Select the Managers tab and click a manager icon. The main window
appears.

TIP: You can also click a manager icon from the managers palette.

Tree structures let you view how items are organized and let you hide or display details.
Expanding displays additional detail; collapsing hides detail.

To collapse or expand a tree
1. Highlight an item.

2. Select the appropriate Tree menu option. Next to each item is a collapse/expand
button. The plus sign (+) indicates that the highlighted item can be expanded at least
one level. The minus (-) sign indicates that all of the levels have been displayed so
that the only action available is collapsing.

Tagging Items

Select an item on the device and media trees (in Device Manager and Media Manager) by
highlighting the icon. These managers process a single item during each operation. Tree
structures with check boxes allow you to tag multiple items before choosing the operation.
Tree structures with check boxes appear in Resource Manager, File Manager, and the session
windows within Media Manager. See chapter 9 for information about finding, sorting, and
filtering the files.

To tag an item

> Highlight the item you want to tag and click the item's check box or
open the Select menu and select Current Item. A red “x” appears next to the
tagged item.

or



> Click the item's check box.
To tag an item and all items beneath it

> Highlight the item and choose SubTree from the Select menu. You can
also highlight the item and type “/.” If you expand the item, you will see that
lower-level items had red “x"s. For example, if you tag a server, all of the
protected resources residing on the server are immediately tagged. If you tag
a directory, its files are tagged as well.

TIP: To untag items after submitting a job or to select different items for the
current job, open the Select menu and select the Clear Tags option.

Attended and Unattended Modes

When you submit a job, you can run it in attended or unattended mode. In unattended
mode, the program determines how to complete the operation based on parameters that
have been configured and information from the configured devices.

In attended mode, the program prompts you to provide instructions in order for the program
to continue. Usually the program prompts the user to load the correct media for the current
job.

Excluding automatic jobs, the program processes jobs in attended mode by default. When
you submit a job, you have the option of choosing unattended mode by turning off the
Prompt With Questions option. If you submit an automatic job ahead of schedule, you
have the opportunity to submit the job in attended mode.

Managing the Job Queue

To view the Job Queue window

> From the Control Console, select the Status tab and click the Job Queue
icon.

TIP: If you are submitting several jobs, you may want to note their job IDs.
Later, you can filter the System Messages window to display only the
messages of a specific job.

The Job Queue window displays all jobs in the queue. Scheduled jobs are indicated by an
“alarm clock” icon. All other jobs are indicated by a “document” icon. In the normal state,
these icons are yellow, if there is a problem, the icons turn red.

When a job has completed successfully, the program sends a system message indicating
that the job completed successfully to the System Messages window. Unless the job repeats,
the job disappears from the Job Queue window. If a jobs fails (its status is “server hold”), the
program assigns the job a new job ID. The system messages describing the failure appear
under the original job ID.

De-activating a Job

Administrators and operators can de-activate (or put on operator hold) jobs. You might do



this to allow a more urgent job to process, to repair a device, or retrieve the required media.
To de-activate a job

> From the Job Queue window, highlight the job you want to de-activate
and select the Hold button. The Status field changes to Operator Hold.

TIP: To put all of the remaining jobs on hold after the program completes

processing the current jobs, select the Halt queue option. The displayed
status of the jobs does not change while the queue is halted.

Activating a Job

Backup Director puts jobs on server hold if they fail. Whether the jobs are on server or
operator hold, they require a user to resubmit them. The job server processes all jobs in the
order in which they were submitted or resubmitted.

To activate a job

1. If the job is on server hold (it appears with a red document or alarm clock icon on the
Job Queue window), highlight it. Select the View button to display the system
messages for this job. Resolve the problems that caused the job to fail. Refer to the
Administrator's Reference Guide, if necessary.

2. From the Job Queue window, highlight the job on hold and choose the Submit button.
> If a scheduled job has not been assigned a job ID, you can also submit
for processing. If the scheduled job has been assigned a job ID, then it is
already due for processing.

3. A prompt asks if you want the program to prompt you with questions (select the

Prompt With Questions option to run in attended mode). Choose your preference.
The job's state changes to “Resubmitted.”

Deleting a Job

To delete a job from the queue

1. From the Job Queue window, highlight the job you want to delete. You can delete jobs
with the status of “Ready,” “Operator Hold” and “Server Hold.”

2. Choose the Delete button. Backup Director asks you to confirm that you want to
delete the job from the queue.

3. Choose Yes.

> If this is a repeating scheduled job that has been assigned a job ID;
only this repetition of the job is deleted. The job server will process the job at
the next scheduled time. To permanently delete the scheduled job, highlight
the scheduled job again and choose the Delete button. The scheduled job no
longer appears in the window.

NOTE: Backup Director does not allow you to delete your
“Default Automatic” job from the database. You can put this job on



operator hold, however.

Adding Users

During the installation process, the program adds the auto login user to the Admin List and
the group EVERYONE to the User List. Users are divided into three types: administrators,
operators, and end users. Each has different rights and are configured in the Configuration
Manager.

NOTE: In 4.x installations, any user who needs to submit file-
level jobs (in other words, accessing File Manager) must be logged in to
the tree where Backup Director is installed.

Administrators are users with full access to all six managers within Backup Director. Only
administrators have access to the programs most powerful functions:

Configuring access to users

Configuring operations and automatic job parameters
Defining file rules

Labeling media

Configuring access to other Backup Director installations

Operators have full access to Control Console and limited access to File Manager. Within
Control Console, operators have the same rights as administrators and are able to manage
the jobs in the queue. You can delegate job monitoring tasks to operators; in most cases
they can respond to device and media messages.

End users can access File Manager only. Operators and end users are able to back up and
restore directories and files for which they have rights. These users can restore data only to
its original location. The Configuration Manager contains the lists of users with access to
Backup Director.

See chapter 9 for information about end user access to File Manager.

Adding Operators and Administrators

To add operators and administrators

1. From the Control Console window, select the Managers tab.

2. Click the Configuration Manager icon on the Managers tab. The Configuration
Manager window appears.

3. Open the Configure menu and select Systems.

4. Select the Admin List tab.

5. Choose the Insert User button and the list of servers on the network appears.

6. Click the server that the user has access to. The list of users defined on that server
appears.

7. Click the user's name. The user appears on the list as an administrator.



8. Choose a user type (Administrator or Operator).

0. Specify which type(s) of notification the user will receive. By default, administrators
are configured to receive NetWare SEND messages on warnings and errors.

> If you specify MHS e-mail notification, also enter the user's e-mail
address and the volume path of the MHS Mail server.

Adding End Users

The User List tab allows you to configure users and groups of users for access to Backup
Director's File Manager. If you are adding end users or end user groups, you need to allow
end users access the File History Database of their resources. See chapter 9 for information
about configuring File Manager for end users.

To add a user (or group)

1. From the Configuration Manager window, open the Configure menu and select
Systems.

2. Select the User List tab.

3. Click the Insert User (or Insert Group) button. The Pick a User to Add (or Pick a

Group to Add) dialog box appears.

4, Select a user from the Pick a User to Add (or Pick a Group to Add) dialog box. The
user (or group) appears in the User list.

See Chapter 4, “Customizing Your Installation,” for information about configuring these
parameters.

Customizing the User Interface

Backup Director allows you to set parameters to determine the appearance of your user
interface. You can customize the display of each manager individually.

The Preferences option, available in every manager, allows you to:
. Display or hide the status bar, which provides information about

activities currently being performed through the user interface, such as
building a directory.

. Display or hide Tool Tips, which provides a brief description of the tool
bar icon's function.
. Change on-screen fonts (This option does not apply to Configuration

Manager and Control Console although you can configure this option to apply
to other managers).
. Display the horizontal scroll bars.

Some options can only be configured in specific managers.
. Save the size and position of all windows. When you next open the

specific manager, the program displays the windows in the same size and in
the same position as they were when you exited.



. Display the alerts and managers palettes throughout program and
display the opening screen (available only in Control Console).

. Configure end user notification (available only in File Manager)

. Display the drive bar (available only in File Manager).

. Configure the end user's workstation names (available only in File
Manager).

. Configure notification for end users (available only in File Manager).

To configure display preferences

1.

From any manager, open the File menu and select Preferences. The Preferences
dialog box appears.

Set your preferences.

Choose OK to save your preferences.




